# Table of Contents

Overview ...................................................................................................................... 3
Program Information .................................................................................................... 3
Child Enrollment .......................................................................................................... 4
Data ............................................................................................................................. 5
Program Summary ....................................................................................................... 6
Equity Profile Alerts .................................................................................................... 9
Quick Links .................................................................................................................. 10
Monthly BIRs by Classroom ID .................................................................................. 10
Problem Behavior ....................................................................................................... 13
Activity, Others Involved, Possible Motivation, Response, Admin Follow Up .......... 14
Distribution by Classroom ID ..................................................................................... 15
Teacher Summary ....................................................................................................... 15
Child Summary ........................................................................................................... 16
Equity Profiles ............................................................................................................ 17
Child ID by ISS_OSS_DIS ......................................................................................... 18
Frequently Asked Questions ....................................................................................... 19

*To accompany file NCPMI_BIR_V2_BLANK.xlsm*
Overview
The Behavior Incident Report System (BIRS) provides early care and education programs and classrooms with a system to collect and analyze behavior incidents in their program. The system provides an efficient mechanism for gathering information on elements related to behavior incidents that can be used analytically to make decisions about providing supports to teachers and children within the program. Teachers within programs collect data on behavior incidents that are not developmentally normative or are a cause of concern to the teacher. These data are summarized monthly to provide formative data for examining factors related to behavior incidents (child, teacher, activity, behavior type, behavior motivation, and responses to the behavior). In addition, these data provide summative information on the frequency of behavior incidents over time and an analysis of potential equity issues by calculating disproportionality related to race, ethnicity, IEP status, gender, and dual language learner status.

Program Information
Before you begin entering data, complete the Program Information tab. This tab should be updated monthly.

Enter the program name and school year.

Next, enter classroom information. Enter the lead teacher’s name followed by the Classroom ID. Incidents will be identified by the Classroom ID, not a teacher ID. Enter the total number of students enrolled in the classroom by month. If a student withdraws from the classroom at any time, do not delete them from the count for that month. The totals across classrooms will automatically update as you enter the data for each classroom.

For each month, enter enrollment by:

- Ethnicity
- Race
- Gender
- IEP status
- DLL status

Make sure your total for the month matches the classroom enrollment total. For Gender you only need to enter the total number of female students. The number of male students will automatically calculate based on the total enrollment for that month minus the total number of females. For IEP and DLL status, you only need to enter how many children have an IEP and are DLL. Excel will automatically calculate how many children do not have an IEP and are not DLL.

Last, enter the number of school days per month.
### Child Enrollment

A child must first be enrolled on the enrollment tab before a BIR can be entered. **You do not need to enroll every child in the program. You should only enroll a child if he/she receives a BIR.** Enter the child’s name, unique child ID (which will be used on any subsequent BIR forms), gender, DLL status, IEP status (yes, they have an IEP or no, they do not), ethnicity, race, and enrollment status. You can also add notes about the child if you wish (i.e., date of first enrollment, classroom switches, disenrollment date, etc.). If a child switches classrooms, they do not need to be enrolled again. Also, if a child is Hispanic or Latino, you do not need to enter their race. For BIR calculation purposes, Hispanic or Latino children of any race are only counted by their ethnicity; they are not counted by their race. In other words, a Hispanic or Latino child who identifies as Black or African American will only count as being Hispanic or Latino of any race, they will not count towards the total number of Black or African American children.

*Please note: If you have more than 175 unique children with behavior incidents, please email veguilla@usf.edu as the file will need to be adjusted to accommodate more children.*
The Data tab is your main data entry tab for recording behavior incidents. Once a classroom is enrolled and a child is enrolled, you can begin to enter incidents. Each row represents a unique incident in the classroom.
In the dropdown for Classroom ID, select the ID for the classroom. You may need to scroll up to find the ID. Do the same for the Child ID.

*If you cannot find the ID for the classroom or the child, refer to the Program Information tab to make sure the teacher has been enrolled and that the right classroom ID has been recorded on the paper form. If you cannot find the child ID, refer to the Child Enrollment tab to make sure the child has been enrolled and that the right child ID has been recorded on the paper form.*

Select the month the incident occurred by looking at the date on the BIR form. Next, enter the date in m/d/yy format. You can enter the time in 12 hour format, however you can enter the time in 12 hour format and enter AM or PM after the time. For example, if it is “10:20 AM”, you can simply enter “10:20.” If it is “1:30 PM”, you can either enter “13:30” or “1:30 PM.” Entering “10:20AM” without a space in between the time and the time period will result in incorrect data.

Next, select the most intrusive problem behavior, the activity, and others involved. If there is more than one person involved, the form should indicate which person was directly affected by the student’s behavior, not who was merely present. Select the possible motivation, the response, and the administrative follow-up (if any).

Do not leave cells blank. Each category has either a “Don’t Know,” “None,” or “Not Applicable” option you can select. Leaving cells blank results in incorrect data.

At the end of the record, you may enter notes if you wish.

**TIP:** If you have many BIRs, you may consider turning off automatic calculation until you are done with data entry. To do this, go to the Formulas tab, Calculation Options (small calculator) and select Manual. When you are done with entry, do the same but select Automatic.

**Program Summary**

The Program Summary tab provides an overview of the behavior incidents in the program as well as any alerts regarding equity.
The user does not need to input anything into this tab. However, before looking at data, the user should update the charts. To update your charts, go to the Data tab on the Excel ribbon and select Refresh All.

To update your charts, scroll down to the Percent of BIRS to Date by Problem Behavior chart on this tab.
Click on the chart and a new tab will appear on the ribbon. This tab is called “PIVOT CHART TOOLS.”

Select “ANALYZE.”

Select “Refresh.” Select “Refresh All.”

Please note that it may take a few minutes for all of the charts to update. Scroll down to see the remaining At-A-Glance charts.
**Equity Profile Alerts**

If there are any possible disparities requiring further analyses, a statement alerting the user will be displayed under the Equity Profile Alerts heading. Click on the alert to go to the tab that will give you more information regarding the alert. Please note: the color of the alert does not have a meaning. It is simply a hyperlink blue or might be color red.

---

![Equity Profile Alerts](image-url)
Quick Links
Quick links are located to the right of the Equity Alerts. These links will take you to different tabs in the workbook. You can click on any of these links to quickly get to that tab.

Monthly BIRs by Classroom ID
On this tab you will have the option of looking at the total number of incidents by classroom ID. On the left-hand side there are 2 options for filtering data. You can filter by Classroom ID, by Month, or by both.
To select a classroom simply click on the classroom ID. If you wish to select more than one classroom, hold down the Ctrl key on your keyboard and click on the other ID or IDs to also select. If you clicked on the incorrect ID, click on the ID again. If you would like to remove all of your filters to show all, click on the filter icon at the top of the selection window.

Alternatively, you can also click on the icon next to the filter icon and then select and deselect your options.

If your chart shows “(blank)” as a Classroom ID option, you can remove this by going to the down arrow at the top of your chart by the Classroom ID and unchecking the box labeled “(blank).” After you uncheck, click OK.
As you filter by Classroom ID the ability to filter by month updates. The Month filter will update based on availability of data based on the Classroom ID option(s) you select. Only months for which there is data will be available for further selection.

By first selecting Classroom ID 2, the months with data for classroom 2 appear (September, October, November, and December). This means classroom 2 does not have data for other months in the year. Clicking on an available month will show data for that particular month only.

If you filter by month first, the classroom IDs that do not have data in that particular month will be a lighter color blue. You will be unable to select these.

These children do not have data for February.
Problem Behavior

The Problem Behavior tab includes several tables and graphs about problem behavior. The table at the top has the number of incidents by month by problem behavior. The bar chart below it represents the percentage of incidents by problem behavior by month. You are able to filter the table and chart by problem behavior(s).

Below is a chart showing the number and percent of incidents by problem behavior. The percent of incidents is graphed in a pie chart. You are able to filter by classroom ID, month, race, ethnicity, gender, DLL and IEP status.

Filter by Problem Behavior, both table and chart

This list is all of the possible problem behaviors

Percent of Total Incidents by Problem Behavior

Social withdrawal/isolation, 11.19%
Physical aggression, 13.87%
Noncompliance, 19.69%
Running away, 8.71%
Inappropriate language, 2.53%
Noncompliance/Tampering, 11.19%
Other, 2.09%

<table>
<thead>
<tr>
<th>Classroom ID</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
<td>September</td>
<td>October</td>
<td>November</td>
<td>December</td>
<td>January</td>
<td>February</td>
<td>March</td>
<td>April</td>
</tr>
<tr>
<td>Class ID</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
</tr>
</tbody>
</table>

Values | % of Total Incidents | Total # of Incidents |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical aggression</td>
<td>20.63%</td>
<td>192</td>
</tr>
<tr>
<td>Non-compliance</td>
<td>13.87%</td>
<td>172</td>
</tr>
<tr>
<td>Inappropriate language</td>
<td>11.19%</td>
<td>83</td>
</tr>
<tr>
<td>Noncompliance/Tampering</td>
<td>7.91%</td>
<td>57</td>
</tr>
<tr>
<td>Running away</td>
<td>7.75%</td>
<td>39</td>
</tr>
<tr>
<td>Inappropriate language</td>
<td>2.53%</td>
<td>11</td>
</tr>
<tr>
<td>Noncompliance</td>
<td>16.80%</td>
<td>20</td>
</tr>
<tr>
<td>Verbal aggression</td>
<td>2.77%</td>
<td>11</td>
</tr>
<tr>
<td>Running away</td>
<td>6.54%</td>
<td>3</td>
</tr>
<tr>
<td>Trouble falling asleep</td>
<td>6.10%</td>
<td>1</td>
</tr>
<tr>
<td>Total</td>
<td>100.00%</td>
<td>728</td>
</tr>
</tbody>
</table>
Activity, Others Involved, Possible Motivation, Response, Admin Follow Up

The following tabs have the same set up. These tabs include several tables and graphs about the specific category of interest (as represented by the tab name). The table at the top has the number or incidents by month by item for that specific category. The bar chart below it depicts the percentage of incidents by item by month. Below that is a table showing the number and percent of incidents by item for that specific category. The percent of incidents are graphed in a pie chart and a bar chart (both provide the same information). Below the table there is another table that shows the number and percent of incidents by item by problem behavior. You are able to filter by classroom ID, month, Ethnicity, Race, Gender, DLL and IEP status.
Distribution by Classroom ID

This tab provides a location for filtering data by any of the categories to provide a table of classroom IDs and total number of incidents. You are able to filter by any of the categories. As you select an item in a category, the other categories will filter out automatically to allow for further filtering. You are able to select more than one item by using Ctrl on your keyboard and clicking on the option. To clear filters, clear the first category you selected. The filter icon will be dark gray and red in comparison to the other filters.

Classroom Summary

The Classroom Summary tab allows you to filter data by classroom ID. Once you select an ID, the tables and graphs on the tab will display data for that classroom only. You are then able to filter by child ID if you wish, however, the next tab, Child Summary allows you to filter by Child ID exclusively. The table on the right hand side shows the number of children for that specific classroom ID and how many incidents each child has recorded in the system.
Child Summary

The Child Summary tab allows you to filter data by child ID. Once you select an ID, the tables and graphs on the tab will display data for that child ID only. To the right of the charts, a table shows you the demographic information for the selected child.
**Equity Profiles**

The equity profiles do not require any data entry or selection of filters/values. These tabs will auto populate based on data entry. However, program demographics by race/ethnicity, gender, DLL and IEP status must be entered on the Program Enrollment tab as well as for each child on the Child Enrollment tab. If you do not enter this data, these tabs will not function properly.

If there is a value that needs further analysis, it will be highlighted red under the Child Composition column and/or highlighted yellow under the Risk Ratio column. Please note, the use of color red and yellow are arbitrary, they do not have any special significance other than to serve as an alert to the user.

---

### Race/Ethnicity/Equity Profile for Incident Reporting

#### Guiding Question 1: Are outcomes equitable for all groups?

#### Guiding Question 2: How big are the disparities?

#### Guiding Question 3: How much of your focal group is affected by disproportionate discipline?

The statement accompanying that value will be highlighted red as well. If a group has no enrollment, the section of statements will be blank.

---

The next chart shows the risk ratio for each category. The first bar chart shows behavior incidents by each category (total enrollment, number of students with an incident, and total number of BIRs). The next chart shows the risk ratio for each category.

---

If you scroll below the statements, bar charts accompany each equity profile. The first bar chart shows behavior incidents by each category (total enrollment, number of students with an incident, and total number of BIRs). The next chart shows the risk ratio for each category.

---

**Behavior Incident Report System (BIRS) Data Entry Guide**

**Page | 17**
Child ID by ISS_OSS_DIS

This tab is used to identify children with an in-school suspension, out-of-school suspension, and/or dismissal. In these filters, the number 0 means no and the number 1 means yes. If you want to filter children that have an ISS, you select the number 1 from the ISS filter. The table will then update showing you the Child ID(s) associated with an ISS. The same is true for OSS and Dismissal (labeled Expulsion). You can also filter by demographic variables.
Frequently Asked Questions

Who does the BIR data belong to?

The BIR System is downloaded by individual early childhood programs. Once the BIRS Spreadsheet is downloaded, it remains within the program. All data entered into the BIRS Spreadsheet belongs to the program and is not accessible to anyone outside that program.

Who can see the data from my program?

Once the BIRS Spreadsheet is downloaded at the program, it remains within the program. All data entered into the BIRS Spreadsheet belongs to that program and is not accessible to anyone outside that program. NCPMI will not collect BIR data from programs.

Is there a cost associated with the BIRS 2.0?

There is no cost to download and use the BIR 2.0 form and the BIRS Spreadsheet.

How does behavior incident data remain confidential within the BIR System?

To maintain child and teacher confidentiality, programs will use a child ID# (instead of child name) and a classroom ID# (instead of classroom name). Care should be taken to develop identification numbers that do not contain easily identifiable information.

How are teachers trained on the use of the BIR form?

Training is available through a recorded 1-hour webinar: https://usf.adobeconnect.com/_a825389370/p34rp0iavkd/.

How long does it take to complete a BIR form?

Once staff are trained on use of the BIR, it takes approximately 30 seconds per incident to complete a form.

Is training available for use on the Excel BIR System?

A link to data entry training can be located within the Instructions tab within the BIRs Spreadsheet. This approximately 45-minute recording explains the data entry process in detail as well as the critical elements of the BIRS Spreadsheet. Data entry staff and the Data Coordinator will require this training.

Who enters the BIR data into the data system?

Each program will want to identify staff within the program who can enter BIR data into the spreadsheet. This data entry person is most often an administrative support staff within the program who has the flexibility within his or her schedule to commit to consistent and timely data entry.

How often should data be entered into the BIRS Spreadsheet?
Programs are encouraged to enter data on a weekly basis, if possible. This allows for continuous monitoring of data quality and ensures that all data are entered in time for monthly Pyramid Model Leadership Team meetings.

I would like to use the BIRS for a large district or state with several regions. Can I use this spreadsheet in that capacity?

Large programs or states should think about using the BIRS on a program-by-program basis versus housing one spreadsheet across multiple sites. The BIRS was developed as a tool for program, classroom, and child level improvement. In the future, NCPMI will develop tools for state-level decision-making.

What are the limits of use for the BIRS spreadsheet?

The BIRS Spreadsheet can hold up to 30 classroom IDs, 175 children, and 1,000 BIR entries. If your program exceeds these numbers, you should contact Myrna Veguilla at veguilla@usf.edu to request additional entries. Please note that after a certain number of BIR entries, the system will be slow. Please refer to the data entry tutorial or data entry guide for tips on how to speed data entry.

Can the BIRS be integrated into my own online system?

Please contact Myrna Veguilla at veguilla@usf.edu to discuss your program needs.

What type of computer/operating system is most compatible with the BIRS 2.0? OR The BIRS spreadsheet does not seem to work on my Mac computer?

The BIRS 2.0 is compatible with:
- Windows operating systems with Microsoft Office 2010 and newer
- Mac operating systems with Microsoft Office 2016
- Office 365

I have entered data into my BIR Spreadsheet but the charts and tables are blank. What should I do?

Programs are encouraged to view the online tutorial for data entry before using the spreadsheet. The link to the online data entry tutorial is found on the first tab of the spreadsheet or by clicking here. Also, refer to page 7 of this guide for more information on updating table and graphs.

Entering data is taking a very long time. What should I do?

Programs are encouraged to view the online tutorial for data entry before using the spreadsheet. The link to the online data entry tutorial is found on the first tab of the spreadsheet or by clicking here. Also, refer to page 6 of this guide for more information on quicker data entry.